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News In Preview

This newsletter's Q and A section describes how to preset the colors for the waveform line and the 
waveform text for the Probe analyses.  The Easily Overlooked Feature section describes the capability 
of  the Cleanup command to automatically delete specified file types every time that the Micro-Cap 
program is exited.

The first article describes how to use the N-Port component to import Touchstone files that contain 
data such as S-parameter information in order to model the frequency response of  a device.

The second article describes a QAM modulator macro which uses amplitude modulation in order to 
convey the signal information of  two separate analog signals.

The third article describes simulating an audio amplifier in the Harmonic Distortion Analysis module 
which can simulate measurements such as THD, THD+N, SINAD, SNR, and individual harmonics.
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Book Recommendations

General SPICE
• Computer-Aided Circuit Analysis Using SPICE, Walter Banzhaf, Prentice Hall 1989. 
 ISBN# 0-13-162579-9

• Macromodeling with SPICE, Connelly and Choi, Prentice Hall 1992. ISBN# 0-13-544941-3

• Inside SPICE-Overcoming the Obstacles of  Circuit Simulation, Ron Kielkowski,  McGraw-Hill, 1993. ISBN# 
0-07-911525-X

• The SPICE Book, Andrei Vladimirescu, John Wiley & Sons, Inc., 1994. ISBN# 0-471-60926-9 

MOSFET Modeling
• MOSFET Models for SPICE Simulation, William Liu, Including BSIM3v3 and BSIM4, Wiley-Interscience, 
ISBN# 0-471-39697-4

Signal Integrity
• Signal Integrity and Radiated Emission of  High-Speed Digital Signals, Spartaco Caniggia, Francescaromana 
Maradei, A John Wiley and Sons, Ltd, First Edition, 2008 ISBN# 978-0-470-51166-4 

Micro-Cap - Czech
• Resime Elektronicke Obvody, Dalibor Biolek, BEN, First Edition, 2004. ISBN# 80-7300-125-X

Micro-Cap - German
• Simulation elektronischer Schaltungen mit MICRO-CAP, Joachim Vester, Verlag Vieweg+Teubner, First 
Edition, 2010. ISBN# 978-3-8348-0402-0

Micro-Cap - Finnish
• Elektroniikkasimulaattori, Timo Haiko, Werner Soderstrom Osakeyhtio, 2002. ISBN# 951-0-25672-2 

Design
• High Performance Audio Power Amplifiers, Ben Duncan, Newnes, 1996. ISBN# 0-7506-2629-1

• Microelectronic Circuits, Adel Sedra, Kenneth Smith, Fourth Edition, Oxford, 1998

High Power Electronics
• Power Electronics, Mohan, Undeland, Robbins, Second Edition, 1995. ISBN# 0-471-58408-8

• Modern Power Electronics, Trzynadlowski, 1998. ISBN# 0-471-15303-6
                                                
Switched-Mode Power Supply Simulation 
• SMPS Simulation with SPICE 3, Steven M. Sandler, McGraw Hill, 1997. ISBN# 0-07-913227-8 

• Switch-Mode Power Supplies Spice Simulations and Practical Designs, Christophe Basso, McGraw-Hill 2008. 
This book describes many of  the SMPS models supplied with Micro-Cap. 
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Micro-Cap Questions and Answers

Question:  I am running a Probe Transient Analysis on my circuit.  I click in the schematic to bring 
up all of  the waveforms that I would like to display.  Then in order to get the plot to look the way I 
would like it to, I go to the Colors, Fonts, and Lines page of  the Analysis Properties dialog box and 
edit all of  the waveform colors and waveform texts to the colors that I want.

I then exit the analysis and make some edits in the circuit.  I then rerun the Probe Transient Analy-
sis, and when I call up the same waveforms, the colors have reverted back to their original settings.  
I need to edit the colors in the Properties dialog box each time I run the probe analysis.  Is there a 
way to preset the waveform colors for a probe analysis, so that I do not need to edit the colors each 
time?

Answer:  The colors for a probe analysis can be preset by going to the Options menu and selecting 
the Default Properties for New Circuits option.  Once the Default Properties dialog box is on the 
screen, open up the Analysis Plots section in the list on the left hand side of  the dialog box.  Select 
the Colors, Fonts, and Lines page within this section.

In the list of  Objects within the Colors, Fonts, and Lines page, there are ten options that are labelled 
Curve 1 through Curve 10.  These objects define the initial settings for each waveform that is in-
voked in a probe analysis.  Selecting any of  these objects will provide the ability to set the curve line 
color, the curve text color, the width of  the curve, the pattern of  the curve, the type of  data point 
marker to be used for the waveform, and whether the Rainbow option will be enabled for the curve.

The colors apply to the order that the waveforms are invoked in the probe analysis and not to a spe-
cific waveform expression.  For example, the colors set for Curve 3 will apply to the third waveform 
that is displayed in the analysis plot.  If  there are more than ten waveforms displayed in the analysis 
plot, the color settings will loop back so that the eleventh waveform uses the Color 1 settings.  These 
settings will apply globally to the Probe Transient, Probe AC, and Probe DC analyses.



�

Easily Overlooked Features

This section is designed to highlight one or two features per issue that may be overlooked among all 
the capabilities of  Micro-Cap.

Cleanup Command: Delete on Exit Capability
The Cleanup command, which is available under the File menu, provides an easy means of  delet-
ing file types such as numeric output, circuit backup, index, probe, Monte Carlo statistic, and Bill of  
Material files along with other files that may be created while working with a circuit.  None of  these 
files are critical to simulating a circuit.

The intention of  the Cleanup command is to provide the user a simple way to delete all of  these 
Micro-Cap associated files en masse.  In older versions, the Cleanup command could only be applied 
manually by the user by accessing the Cleanup dialog box.  In Micro-Cap 10, the capability now ex-
ists to have Micro-Cap delete specified file types every time that the program is exited.

The Cleanup dialog box is displayed below.  The left side of  the dialog box displays a list of  all 
of  the file types that can be deleted through this command.  Next to each file type is a checkbox.  
When a checkbox has been checked, the corresponding file type will be deleted every time that the 
program is exited.  The folders that these file types will be deleted from are specified in the Paths 
dialog box which is available under the File menu.  By default, Micro-Cap will only display the file 
types that have associated files available to be deleted.  The Show All option will display all possible 
file types in the list whether or not there are any files of  that type in the searched paths.

This capability can be very useful when a user has an automated backup system.  It can frequently 
delete Micro-Cap files that are not important to the simulation which one usually does not want 
present in the backup storage.

Fig. 1 - Cleanup dialog box
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Using the N-Port Component

The N-Port component is a general device that has N ports characterized by a set of  S-, Y-, G-, H-, 
T-, or ABCD-parameters that are contained in a standard Touchstone data file.  The Touchstone 
files are typically provided by RF suppliers who model the frequency response of  a device through 
a table of  values in the file.  The S-parameter data is the most common format used within Touch-
stone files.

The Touchstone data can be used to simulate the frequency response of  any number of  component 
types with examples such as inductors, transistors, SAW filters, ferrite beads, and EMI filters avail-
able from EPCOS and On Semi.

The N-Port component can have any number of  ports.  Micro-Cap is distributed with four N-Port 
devices that simulate one port through four ports.  These devices are available in the Analog Primi-
tives \ N-Port section of  the Component menu.  If  more than four ports are needed, a new N-Port 
device would need to be created in the Component Editor.

The N-Port component can greatly simplify a circuit for an AC analysis simulation.  Rather than 
having to create an elaborate SPICE model of  a device, the N-Port component can be used as a 
black box to easily model the frequency response of  the device.

The schematic below displays an example of  a circuit that uses an N-Port component to model a 
SAW (Surface Acoustic Wave) filter.  The circuit was created from an EPCOS application note (Ref  
1).  It models a GPS low noise front-end amplifier with a SAW filter.  The structure of  this circuit is 
based on a LNA (Low Noise Amplifier) - Filter - LNA topology.  The filter portion of  the topology 
is represented by a Two-Port N-Port component that models the frequency response of  a B3520 
SAW filter.

Fig. 2 - GPS front end circuit
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The N-Port component has one main attribute that needs to be defined.  This is the FILE attribute 
which specifies the name and optionally the location of  the Touchstone file that is to be used to 
import the data from.  In this circuit, the FILE attribute has been defined as follows:

FILE = B3520_WB.s2p

Since no path has been specified, the file should be located in the Data folder that has been specified 
in the Paths dialog box under the File menu.  The default path location is the DATA folder under 
the main Micro-Cap folder.  The B3520_WB.s2p Touchstone file for the B3520 SAW filter was 
downloaded from the EPCOS website.  It consists of  a table whose data values are in the S-param-
eter format.  A portion of  the file is displayed below.

# MHz  S  MA  R  50
!
!  Freq          S11                S21                S12                S22
1075.750 9.475E-01 -159.23 4.729E-03   76.27 4.729E-03   76.27 9.207E-01 -164.49
1078.250 9.481E-01 -159.46 4.975E-03   72.56 4.975E-03   72.56 9.217E-01 -164.71
1080.750 9.464E-01 -159.75 4.706E-03   70.22 4.706E-03   70.22 9.177E-01 -164.77
1083.250 9.475E-01 -159.93 4.664E-03   72.08 4.664E-03   72.08 9.198E-01 -165.08
1085.750 9.466E-01 -160.17 4.906E-03   73.28 4.906E-03   73.28 9.214E-01 -165.22
1088.250 9.465E-01 -160.39 5.142E-03   70.27 5.142E-03   70.27 9.221E-01 -165.44
....
....
....
2063.250 8.704E-01  158.89 1.467E-03   38.46 1.467E-03   38.46 8.503E-01  159.34
2065.750 8.699E-01  158.94 1.358E-03   42.80 1.358E-03   42.80 8.504E-01  159.37
2068.250 8.702E-01  158.79 1.281E-03   42.10 1.281E-03   42.10 8.505E-01  159.21
2070.750 8.695E-01  158.67 1.268E-03   39.47 1.268E-03   39.47 8.491E-01  159.12
2073.250 8.690E-01  158.47 1.077E-03   43.97 1.077E-03   43.97 8.495E-01  159.03
2075.750 8.674E-01  158.47 9.509E-04   39.53 9.509E-04   39.53 8.497E-01  159.02

This file simulates the frequency response of  the B3520 filter over a frequency range of  
1075.75MHz to 2075.75MHz with a frequency step every 2.5MHz.  During the simulation, Micro-
Cap will interpolate between the data points as needed.  The data for each S-parameter is in a magni-
tude - angle pair.  The S-parameters were measured using a reference resistance of  50 ohms which is 
the real impedance to which the S-parameters were normalized to in the file.

Since the data within the Touchstone file is limited to a specific frequency range, the AC analysis will 
only be meaningful within this same range.  If  the frequency simulated in the AC analysis is less than 
the frequency range in the file, then the data from the first data point will be used.  If  the frequency 
simulated is greater than the frequency range in the file, then the data from the last data point will be 
used.

Note that Micro-Cap determines the number of  ports that are being modelled by the Touchstone 
file through the extension of  the file name.  The extension format should be:

.XnP

where X is the parameter type that is being used and n is a number that defines the number of  ports 
that are being modelled in the file.  For the B3520 file, the extension is .S2P since it is a 2-port S-
parameter file.
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Fig. 3 - GSP front end AC analysis

The AC analysis simulation of  the GPS circuit is shown below.  The simulation has been run over 
a frequency range of  1075.75MHz to 2075.75MHz which is the frequency range of  the data in the 
Touchstone file.  The waveform displayed in the plot is the output voltage of  the circuit in decibels 
which is plotted through the expression:

dB(V(Out))

The L1 band of  the GPS system, which covers civilian use, broadcasts at 1575.42MHz.  As can be 
seen in the frequency response of  the system, this frequency lands squarely in the passband region 
of  the output.

References:
1) EPCOS Application Note #16, "GPS low noise front-end amplifier with SAW filter B3520"
http://www.epcos.com/web/generator/Web/Sections/ProductCatalog/SAWComponents/Auto-
motiveElectronics/Resonators/PDF/PDF__AN16,property=Data__en.pdf;/PDF_AN16.pdf



�

QAM Modulator Macro

The analog QAM (Quadrature Amplitude Modulation) scheme uses amplitude modulation in order 
to convey the signal information of  two separate analog signals.  The term quadrature refers to two 
periodic waveforms whose phase difference is one fourth of  their period.  The two carrier waves 
used within the QAM modulation are sinusoidal and out of  phase by 90 degrees which make them 
quadrature carriers.

The output of  the QAM modulator is in the form:

Out(t) = In1(t) * Cos(2*PI*F0*T) + In2(t) * Sin(2*PI*F0*T)

where In1(t) and In2(t) are the two signals to be modulated and F0 is the carrier frequency.  This equa-
tion can be easily modelled within Micro-Cap.  The QAM modulator can be simulated through the 
macro circuit shown below.

Fig. 4 - QAM modulator macro circuit

The QAM modulator macro circuit has one parameter.  The F0 parameter defines the carrier frequency 
for the quadrature carriers.  The two input nodes for the macro are InCos and InSin.  The InCos input 
is for the signal that is to be modulated by the cosine carrier.  The InSin input is for the signal that is to 
be modulated by the sine carrier.  The InCos input is fed into the X2 Mul component which multiplies 
the input signal by the cosine carrier wave.  The cosine carrier wave is produced by the E1 NFV source 
whose VALUE attribute is defined as:

Cos(2*PI*F0*T)

The InSin input is fed into the X3 Mul component which multiplies the input signal by the sine carrier 
wave.  The sine carrier wave is produced by the E2 NFV source whose VALUE attribute is defined 
as:
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Fig. 5 - QAM modulator test circuit

Sin(2*PI*F0*T)

The output of  both Mul components are then summed through the X1 Sum component which pro-
duces the final modulated signal.

An example circuit using the QAM modulator macro appears below.  The inputs to the QAM modula-
tor consist of  a pair of  sine signals.  The V1 voltage source produces a .75V, 20kHz sine wave, and the 
V2 voltage source produces a .6V, 50kHz sine wave.  The QAM modulator macro has its F0 parameter 
defined as 1Meg in order to produce 1MHz carrier signals.

The output of  the QAM modulator is then demodulated through the use of  a product detector de-
modulator.  This demodulator multiplies the modulated signal separately by cosine and sine signals 
that are identical to those used for the carrier waveforms.  Multiplying the modulated signal by a cosine 
signal produces the waveform:

In1(t) * Cos(2*PI*F0*T) * Cos(2*PI*F0*T) + In2(t) * Sin(2*PI*F0*T) * Cos(2*PI*F0*T)

Using the standard trigonometric identities where:

Cos(2*PI*F0*T) * Cos(2*PI*F0*T) = .5 * (1 + Cos(4*PI*F0*T))
Sin(2*PI*F0*T) * Cos(2*PI*F0*T) = .5 * Sin(4*PI*F0*T)

The equation can be rewritten as:

.5 * In1(t) + .5 * In1(t)*Cos(4*PI*F0*T) + .5 * In2(t) * Sin(4*PI*F0*T)

Removing the higher frequency terms would leave just the .5*In1(t) signal.  The modulated signal that 
is multiplied by the sine signal would operate in a similar manner.
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Fig. 6 - QAM modulation/demodulation transient analysis

A low pass Butterworth filter is used to remove the higher frequencies from each of  the demodulated 
signals.  This filter was created through the Passive Filter Designer in Micro-Cap.  It is designed to have 
a passband gain of  0dB and a passband frequency of  100kHz.

Finally, an Amp component is used at each output to restore the signal back to its original magnitude.  
To compensate for the attenuation caused by the demodulator and the resistances at the input and 
output of  the filters, the Gain parameters for the Amp components are set to 4.  The resulting transient 
analysis is shown below.

The top plot displays the modulated signal at the output of  the QAM modulator.  The middle and bot-
tom plots display the original input signals to the QAM modulators and their corresponding outputs 
from the demodulation circuitry.

A delay has been introduced due to a phase shift from the low pass filter, but other than that the input 
signals have been replicated nicely at the output of  the demodulator.
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Simulating an Audio Amplifier in Harmonic Distortion Analysis

The Harmonic Distortion analysis available in Micro-Cap applies a sinusoidal signal at the input of  a 
circuit, steps frequencies and amplitudes specified by the user on this signal, and then measures the 
resulting distortion at the specified load resistor.

If  a pure, single frequency, sine wave signal is applied to the circuit input, and if  the circuit is perfectly 
linear, the output will be a sinusoid at the same frequency.  The spectral content of  the input and output 
will be the same except possibly in amplitude and phase.  There will be no distortion.

If  the circuit is not perfectly linear, some output signal level will be found at frequencies other than the 
input frequency.  In other words, distortion will occur.  The Harmonic Distortion analysis is designed 
to simulate measurements such as THD, THD+N, SINAD, SNR, and the magnitudes of  individual 
harmonics.  For distortion measurements such as IM2 and IM3, Micro-Cap has a separate Intermodu-
lation Distortion analysis that can simulate these.

For Harmonic Distortion, a Sine source or a Voltage Source or Current Source of  type SIN must be 
connected to the circuit input.  Its frequency and amplitude will be set by values from the Harmonic 
Distortion Analysis Limits dialog box.

One area of  engineering where harmonic distortion measurements are extremely useful is with audio 
amplifiers.  The circuit below displays the Hiraga 20W Class A amplifier (Ref  1) that will be used 
throughout this article to display the capabilities of  the Harmonic Distortion analysis.

Fig. 7 - Hiraga 20W Class A amplifier

The Harmonic Distortion analysis can be entered by selecting Harmonic Distortion under the Analy-
sis menu.  The Harmonic Distortion Analysis Limits dialog box will then appear in order to set the 
simulation settings for the run.  The Limits dialog box appears in Figure 8.
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Fig. 8 - Harmonic Distortion Analysis Limits dialog box

The fields unique to Harmonic Disortion analysis are:

Fundamental Frequency:  This sets the frequency of  the input source in the circuit.  This frequency will 
also be used as the fundamental frequency in the distortion calculations.  The frequency can be stepped 
within this field with the standard log, linear, or list formatting or just a single value can be used.

Name of  Input Source:  This specifies the name of  the source that is to be used as the input.

Input Source Amplitude:  This sets the amplitude of  the input sine wave.  The amplitude can be stepped 
within this field with the standard log, linear, or list formatting or just a single value can be used.

Name of  Load Resistor:  This specifies the name of  the load resistor used to measure the distortion.

Noise Frequency Range:  This is the frequency range over which the noise will be measured for the 
THDN, SINAD, and SNR calculations.

The Periodic Steady State option in the limits is recommended for most simulations.  This typically 
finds a more accurate result in less time.  However, it is not ideal for all cases.  When the Periodic Steady 
State option is disabled, the following two fields are used.

Max Simulation Cycles:  This is the number of  periods each step will be run for.  Micro-Cap will only 
use the last cycle for the distortion calculations.

Steady State Tolerance:  If  two successive cycles fall within this relative change tolerance then the simu-
lation will finish early rather than simulating the maximum number of  cycles.  Set this field to zero if  
you want the program to complete all of  the Max Simulation Cycles.
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Time Step Ratio:  This controls the maximum time step as follows:

Maximum Time Step = Time Step Ratio/Fundamental Frequency

Highest Harmonic in THD:  This specifies the largest harmonic that will be used when calculating the 
THD measurements.

A preset group of  waveforms is specified in the waveform expression section of  the Limits dialog 
box.  These are waveforms that are necessary to perform the distortion calculations.  While the user 
can add their own waveforms into the dialog box, they cannot remove this set of  waveforms, but they 
can choose whether to plot them or not.

Upon running the simulation, any waveforms that have been enabled to plot are displayed in the 
Harmonic Distortion Analysis window.  While this data is often of  interest, the real strength of  the 
Harmonic Distortion is in the capabilities of  the Harmonic Distortion Window performance plots 
which are used to mine data from the preset group of  waveforms specified in the Limits dialog box.

When the Harmonic Distortion analysis has finished, the Add Harmonic Distortion Window can be 
selected from the Harmonic Distortion / Harmonic Distortion Windows menu.  This command opens 
the Harmonic Distortion Window Properties dialog box shown below.

Fig. 9 - Plot page of  the Harmonic Distortion Window Properties dialog box

The Plot page of  the Properties dialog box defines the plot(s) that will be displayed in the Harmonic 
Distortion Window.  The X Axis section selects the variable that will be plotted along the X axis.  The 
following variables are available:
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F - The fundamental frequency
VIN - The input voltage level
VOUT - The output voltage level
PIN - The input power level
POUT - The output power level

The Show As section chooses whether to plot the X axis variable in dB, dBm, or the value of  the se-
lected variable.  Not all options are available for each X-Axis variable.

The Y Axis section selects the variable that will be plotted along the Y axis.  The following variables 
are available:

THD - Total harmonic distortion
THDN - Total harmonic distortion + noise
SINAD - Signal to noise and distortion ratio
SNR - Signal to noise ratio
Hn - The value of  the n'th harmonic.  The text field next to the H option controls the harmonic num-
ber.  For example, if  a 3 is entered in this field, then the third harmonic will be plotted.

The Type section chooses whether the Y axis variable will be plotted as a voltage or power representa-
tion.

The Show As section chooses whether to plot the Y axis variable in %, dB, dBm or the value of  the 
selected variable.

The Form section chooses whether the X and Y variables will be plotted using their peak values or 
their RMS values.  For the Y axis variables, only the individual harmonic plots will be affected by the 
RMS option since the other variables are all ratios.

The Designator section chooses how the Y variables will be labelled in the plot.  The Simple option 
will designate the variable with just the basic variable name such as THD.  The Literal will create more 
complex names based on the selections such as THDV to designate that the THD is in voltage.

The Buffer field lets a waveform be imported into the plot from the Waveform Buffer.

The What to Plot section chooses which branch of  a stepped variable will be chosen for the plot if  
more than one variable has been stepped.

Plot Group:  This selects the plot group that the plot will be placed in.

Labels: When enabled, a text label will be placed in the plot that describes any individual stepped pa-
rameters that apply to the plot.

Except for the Numeric Output page, all of  the other pages in the Properties dialog box operate in 
the same manner as they do in the other analyses.  The Numeric Output page will be described later 
in this article.

For the initial run of  the Hiraga amplifier in Harmonic Distortion, the RL resistor is setup in the Step-
ping dialog box to step between the values of  2 ohms, 4 ohms, and 8 ohms.  These are the common 
load resistor values for audio amplifiers.
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In the Harmonic Distortion Limits, the Fundamental Frequency field is set to 1kHz.  The Input Source 
Amplitude field is set to:

2, 2m, 1.5

with the Step method chosen as Log.  The remaining settings are set as shown in the Limits dialog box 
previously.  The data generated in the Harmonic Distortion Analysis window is shown below.

Fig. 10 - Harmonic Distortion Analysis window

The top plot displays the harmonics produced at the voltage output of  the amplifier across the RL 
resistor.  The middle plot displays the actual voltage at the load resistor.  Note the clipping that is oc-
curring at the higher voltage outputs.  The bottom plot displays the total harmonic distortion of  the 
output.  With the amplitude of  the input source and the load resistor both being stepped, there are 57 
branches for each of  the waveforms.  This is an abundance of  data and the reason why the Harmonic 
Distortion Plots are so valuable in distilling all of  this data into simpler plots.

The first Harmonic Distortion Plot created from the above simulation is shown in Figure 11.  This plots 
the THD versus the output power of  the amplifier for each of  the three steps of  the load resistance.  
The THD value is in percentage while the output power is in RMS Watts.  Note that all THD calcula-
tions in these Harmonic Distortion Plots will use only the first ten harmonics as that is the value set 
in the Highest Harmonic in THD field in the Limits dialog box.  As expected, the THD increases as 
the power increases.

The second Harmonic Distortion Plot is shown in Figure 12.  This plots the 2nd, 3rd, 4th, and 5th 
harmonics of  the output voltage versus the output power for the instance when the load resistor is 
set to 2 ohms.  Each of  the harmonics are plotted with their RMS values in decibels while the output 
power is in RMS Watts.  The harmonics for the instances where the load resistance is 4 ohms or 8 ohms 
could also have easily been plotted in the same window or a separate window.
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Fig. 11 - THD vs RMS output power at RL=2, 4, and 8 ohms

Fig. 12 - Harmonics vs RMS output power at RL=2 ohms
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The third Harmonic Distortion Plot for this simulation is shown below.  This plots the THD+N and 
THD versus the output power of  the amplifier for the instance when the load resistor is at 8 ohms.  
Both of  the distortion plots are plotted in percentage, and the output power is again in RMS Watts.  
As can be seen in the plot, the noise dominates the distortion when the amplifier is operating at low 
power but has a negligible effect when the amplifier is operating at higher power.

Fig. 13 - THD+N and THD vs RMS output power at RL=8 ohms

For the next simulation run on the Hiraga amplifier, the Fundamental Frequency field in the Harmonic 
Distortion Limits dialog box is set to:

200k, 20, 1.2

with the Step method set to Log.  The Input Source Amplitude is set to 260mV.  The amplitude is 
defined with a value that will not cause any clipping at the amplifier output.  The remaining settings 
stay the same.

The Harmonic Distortion Plot shown in Figure 14 is created from the new simulation.  This plots 
the THD versus the fundamental frequency of  the input signal when the load resistance is at 4 ohms.  
The THD is in percentage and the frequency is in Hz.  The Hiraga amplifier is an exceptionally linear 
amplifier.  At 20Hz, the THD is at .045%, and at 200kHz, the THD has only risen to .075%.

While the Harmonic Distortion Plots provide a good visual representation of  the data, the numeric 
output capability of  these plot windows can also be used to provide a useful table of  values.  The Nu-
meric Output page of  the Harmonic Distortion Window Properties dialog box is displayed in Figure 
15.  This dialog box can be invoked by double clicking or hitting F10 in any Harmonic Distortion Plot 
window.
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Fig. 14 - THD vs frequency at RL=4 ohms

Fig. 15 - Numeric Output page of  the Harmonic Distortion Window Properties dialog box
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Fig. 16 - Numeric Output results for the second Hiraga simulation

All of  the Harmonic Distortion Plot variables are available for the numeric output whether they are 
being plotted or not in the window.  The input variables (F, VIN, VOUT, PIN, and POUT) along with 
the output variables (THD, THDN, SINAD, SNR, and Hn) can all be printed in a single table.  The 
Hn values are available for the first through the ninth harmonics.  The list in the Variables to Print 
section displays all of  the configurations for the variables that can be printed.  A check in the checkbox 
enables that variable for the numeric output file.  Each variable is labelled with their literal name along 
with their units.  Some examples:

VOUT_RMS(dBV) - Prints the RMS output voltage in dBV
SNRP(dBmW) - Prints the signal to noise ratio of  the power in dBm
H3V(%V/V) - Prints the voltage value of  the third harmonic in %

Once the appropriate waveforms are enabled, clicking the Create button will create the numeric out-
put file.  A sample file created from the second Hiraga simulation where the frequency was stepped is 
shown below.  The table shows the specified expression values for each fundamental frequency that was 
stepped in the simulation.  In this case, the RMS output power, THD, THDN, SINAD, SNR, second 
harmonic, third harmonic, and fourth harmonic values are all included in the table.  Note the comment 
at the top of  the table that describes the parameter values of  the simulation step for this table along 
with the noise value that was calculated for this circuit and is used in the THDN, SNR, and SINAD 
calculations.  The noise value is calculated across the bandwidth specified by the user in the Noise 
Frequency Range field in the Limits dialog box which in this case is between 20Hz and 20kHz.

Many thanks to Sigurd Ruschkowski for helping in the development of  this article.

References:
1) "Construction of  a 20W Class A Amplifier 3 - The final version", Jean Hiraga and Gerard Chretien, 
http://www.tcaas.btinternet.co.uk/hiraga3.htm
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